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consent of Renesas Electronics.  The quality grade of each Renesas Electronics product is “Standard” unless otherwise 
expressly specified in a Renesas Electronics data sheets or data books, etc. 

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual 
equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots. 
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MS-DOS, Windows, and Windows NT are either registered trademarks or trademarks of Microsoft Corporation in the

United States and/or other countries.

PC/AT and PC DOS are trademarks of International Business Machines Corporation in the United States.

M8E  00. 4

The information in this document is current as of January, 1999. The information is subject to 
change without notice.  For actual design-in, refer to the latest publications of NEC's data sheets or 
data books, etc., for the most up-to-date specifications of NEC semiconductor products.  Not all 
products and/or types are available in every country.  Please check with an NEC sales representative 
for availability and additional information.
No part of this document may be copied or reproduced in any form or by any means without prior       
written consent of NEC.  NEC assumes no responsibility for any errors that may appear in this document.
NEC does not assume any liability for infringement of patents, copyrights or other intellectual property rights of 
third parties by or arising from the use of NEC semiconductor products listed in this document or any other 
liability arising from the use of such products.  No license, express, implied or otherwise, is granted under any 
patents, copyrights or other intellectual property rights of NEC or others.
Descriptions of circuits, software and other related information in this document are provided for illustrative 
purposes in semiconductor product operation and application examples. The incorporation of these 
circuits, software and information in the design of customer's equipment shall be done under the full 
responsibility of customer. NEC assumes no responsibility for any losses incurred by customers or third 
parties arising from the use of these circuits, software and information.
While NEC endeavours to enhance the quality, reliability and safety of NEC semiconductor products, customers 
agree and acknowledge that the possibility of defects thereof cannot be eliminated entirely.  To minimize 
risks of damage to property or injury (including death) to persons arising from defects in NEC 
semiconductor products, customers must incorporate sufficient safety measures in their design, such as 
redundancy, fire-containment, and anti-failure features.
NEC semiconductor products are classified into the following three quality grades:
"Standard", "Special" and "Specific".  The "Specific" quality grade applies only to semiconductor products 
developed based on a customer-designated "quality assurance program" for a specific application.  The 
recommended applications of a semiconductor product depend on its quality grade, as indicated below.  
Customers must check the quality grade of each semiconductor product before using it in a particular 
application.
 "Standard": Computers, office equipment, communications equipment, test and measurement equipment, audio

and visual equipment, home electronic appliances, machine tools, personal electronic equipment
and industrial robots

"Special": Transportation equipment (automobiles, trains, ships, etc.), traffic control systems, anti-disaster
systems, anti-crime systems, safety equipment and medical equipment (not specifically designed
for life support)

"Specific": Aircraft, aerospace equipment, submersible repeaters, nuclear reactor control systems, life
support systems and medical equipment for life support, etc.

The quality grade of NEC semiconductor products is "Standard" unless otherwise expressly specified in NEC's 
data sheets or data books, etc.  If customers wish to use NEC semiconductor products in applications not 
intended by NEC, they must contact an NEC sales representative in advance to determine NEC's willingness 
to support a given application.
(Note)
(1) "NEC" as used in this statement means NEC Corporation and also includes its majority-owned subsidiaries.
(2) "NEC semiconductor products" means any semiconductor product developed or manufactured by or for

NEC (as defined above).
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Major Revision in This Edition

Page Description

p.19 Figure 2-6 Screen Configuration  is modified.

The mark    shows major revised points.
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INTRODUCTION

Target Readers This manual is targeted at users who will employ the NEC CMOS LSI for On-Screen

Character Display (OSD-use LSI) when developing character patterns (character

design) using a mask code option.

Purpose The aim of this manual is to explain the process from character pattern creation

(design) to product ordering.

Organization This manual is organized into the following sections.

•••• Outline

•••• Basic Operating Procedures

•••• Function Details

•••• Error Messages and Device Information

•••• Ordering Mask ROM for OSD-Use LSI

How to Read This Manual The readers of this manual need to have basic knowledge of OSD-use LSI usage

and the operation of Windows.

Conventions Note : Footnote for item marked with Note  in the text

Caution : Information requiring particular attention

Remark : Supplementary information

Numerical representation: Binary… ××××
Decimal… ××××
Hexadecimal…××××H

Related Documents The related documents indicated in this publication may include preliminary versions.

However, preliminary versions are not marked as such.

Document Name Document No.

µPD6461, 6462  Data Sheet S13320E

µPD6464A, 6465  Data Sheet S11043E

µPD6466  Data Sheet S10991E

On-Screen Display LSI  User’s Manual S13197E

Character Pattern Editor for On-Screen Display LSINote  User’s Manual S10153E

Character Pattern Editor for On-Screen Display LSI  User’s Manual  for Windows This Manual

ROM Code Ordering Method  Information C10302J

Note For MS-DOS™ (PC-9801 Series) and PC DOS™ (IBM PC/AT™ and compatibles)

Caution The related documents listed above are subject to change without notice.  Be sure to use the

latest version of each document for designing.
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CHAPTER  1   OUTLINE

1.1 Features

The features of the “Character Pattern Editor for Windows” are described below.

(1) High compatibility with DOS environment

Because most of the command functions in DOS are deployed in the Windows menu, functions on a par with

those of DOS can be realized simply by choosing the desired function from the menu.  Moreover, the use of the

same data-save file format (*.OUT, *.SAV) as DOS means that data used in the DOS format can be used in

Windows with no modification.

(2) Easy operability and superior user interfacing

Frequently used functions can be executed with just one button via the toolbar.

A MDI (Multiple-Document Interface) makes it possible to manipulate multiple files (data) on the same screen,

which in turn simplifies cut, copy, and pasting between files.

By using a format that divides the window into four sections, the split window format, the pattern edit, image

view, hex dump, and option data editing functions become accessible on the same screen, making it possible for

the user to reference and edit a large volume of data.
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1.2 System Configuration

The basic equipment in this system is shown below.

Figure 1-1.  Basic Equipment Configuration

(1)  Personal computer

(2)  PROM programmer

(3)  Printer

Serial interface

Parallel interface

(1) Personal computer

Personal computers that operate Windows 3.1J

(PC-9801 Series, IBM PC/AT and compatibles, etc.)

(2) PROM programmer Note

AF-9703, AF-9704 (Products of Ando Electric Co., Ltd.)

(3) Printer

Printers that support PCs and Windows 3.1J

Note This is not necessary for creating character patterns.  Use a floppy disk when ordering mask ROM.

Orders are not being received for UVEPROM.
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1.3 Software Configuration

The configuration of the PC software necessary for this system is shown below.

•  MS-DOS 5.0J or later, or PC DOS 6.1J or later

•  Windows 3.1J

•  Character Pattern Editor for Windows



User’s Manual  S13317EJ1V1UM0014

[MEMO]



User’s Manual  S13317EJ1V1UM00 15

CHAPTER  2   BASIC  OPERATING  PROCEDURES

2.1 System Connection and Interface Setting

The PROM programmer is connected as described below.  It is unnecessary to connect a PROM programmer

unless it is being used in character pattern creation.  Use a floppy disk when ordering mask ROM.  Orders are not

being received for UVEPROM.

• Use a cross RS-232C cable to connect PROM programmers AF-9703 and AF-9704 to the PC.

• PROM programmer interface

Match the interface setting of the AF-9703 and AF-9704 to the connecting PC using function key F4.

2.2 Character Pattern Editor Installation

To install the Character Pattern Editor, open the Program Manager, click [Run ], and execute the SETUP.EXE

instruction in the installation disk.  An example of the Character Pattern Editor installation disk operating in C drive is

shown in Figure 2-1.

Figure 2-1.  Run Screen
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When SETUP.EXE is executed, the installer will be activated, and the window shown in Figure 2-2 will be

displayed.

Figure 2-2.  OSD Setup Screen

From here, the Character Pattern Editor can be setup by specifying the target installation files in accordance with

the installer’s messages.

When installation is complete, the message box shown in Figure 2-3 will be displayed.

Figure 2-3.  Installation-Complete Screen

When installation is complete, use the File Manager or a DOS prompt to copy Mfc250.dll, which is in the

installation disk, to the OSD directory created during setup.

When using a DOS prompt, input the directions in the following way.

$=�!&23<###&=�0)&5831'//###$=�26'

Remark A:¥OSD → The directory that installed the Character Pattern Editor

C: → The drive in which the installation disk is operating
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2.3 Startup and Exit

(1) Turn on the power supply of the peripherals such as the display and printer, and of the main PC unit (and of the

PROM programmer, if being used).

(2) Open the control panel of Windows 3.1J, and click the serial port setting icon.

(2) is unnecessary when the PROM programmer is not used.

Figure 2-4.  Control Panel Icon

Because the serial port setting window will have been activated, make the settings in accordance with the table

below.

For details on the operation of the control panel, refer to Windows 3.1 Operation Manual .

Cautions 1. When writing to PROM, be sure to select PROM programmer RS-232C-0 (RS-232C-1 and RS-

232C-2 cannot be selected).

2. The data set is saved.  Except when modifying, serial port resetting is unnecessary.

•••• Interface parameters

AF-9703, AF-9704

Baud rate 9,600 bps

Data length 7 bits

Parity Even numbers

Stop bit 2 bits

X parameter OFF
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(3) Make the settings for the interface and the communication mode on the PROM programmer side.  Use the

PROM programmer buttons in accordance with the table below.

(3) is unnecessary when the PROM programmer is not used.

•••• Interface settings

Operation

AF-9703  FUNCTION    4 

 9   6   0   0  V  0   SET 

AF-9704  FUNCTION    4 

V Pressing this several times causes [9600] to appear

W

V Pressing this several times causes [7BIT] to appear

W

V Pressing this several times causes [ENV] to appear

W

V Pressing this several times causes [SP2] to appear

•••• Communication mode settings

Operation How to Check

AF-9703, AF-9704  FUNCTION    9 

 SET 

Display section, buzzer

(4) The Character Pattern Editor is activated after clicking the Character Pattern Editor icon (which is automatically

registered following the completion of installation).

Figure 2-5.  Character Pattern Editor Icon

(5) To exit the Character Pattern Editor, choose Exit from the [File] menu in the Character Pattern Editor.
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2.4 Screen Configuration

2.4.1 Screen configuration
The screen configuration of this system is shown below.

Figure 2-6.  Screen Configuration

(2)  Toolbar

(1)  Menu

(3)  MDI window

(4)  Pattern Edit window

(5)  Image View window

(6)  Hex Dump window

(8)  Status bar

(7)  Option Data Edit window
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(1) Menu

Most of the DOS command functions are included (Refer to 2.4.2 Comparison of DOS and Windows for

details).

•••• File menu

Menu Item Outline

New(N)… Opens a new window after the target device has been selected.

Open(O)… Opens an existing file (*.SAV, *.OUT).

Close(C) Closes the active window.

Save(S) Updates and saves the file contents.

Save As(A)… Saves the file contents in a separate file (*.SAV, *.OUT).

Print(P)… Prints the contents of the active window (such as the Image View or Hex Dump window).

Preview(V) Displays on the screen for confirmation the contents that are to be printed.

Printer Set(R)… Sets the printer to be used.

Exit(X) Exits the Character Pattern Editor.

•••• Edit menu

Menu Item Outline

Undo(U) Cancels the previous edit operation (the maximum number of undo operations possible depends

on the memory).

Cut(T) Removes the contents in a specified area and copies them to the clipboard.

Copy(C) Copies the contents in a specified area to the clipboard.

Paste(P) Inserts the contents of the clipboard into the document.

Delete(D) Deletes the contents in a specified area.
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•••• Palette menu

Menu Item Outline

ERASE Chooses the eraser tool.

PEN Chooses the pencil tool.

SELECT Chooses the rectangle selection tool.

PAINT Chooses the paint bucket tool.

LINE Chooses the line tool.

RECT Chooses the rectangle tool.

CHG UD Turns the character upside down (the same function as the vertical flip tool).

CHG LR Turns the character back to front (the same function as the horizontal flip tool).

•••• View menu

Menu Item Outline

Editor(E) Switches on and off the display of the Pattern Edit window.

Option Data(O) Switches on and off the display of the Option Data Edit window.

Tool Bar(T) Switches on and off the display of the toolbar.

Status Bar(S) Switches on and off the display of the status bar.

Pack(A)… Switches to the Pack format.

Propaty(P) Displays device information, option data, etc.

Zoom(Z)… Changes the scale of the Pattern Edit window and the Image View window.
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•••• ROM menu

Menu Item Outline

Setup(S)… Sets the PROM programmer and PROM types.

Blank Check(Z)… Checks the status of the PROM write operation.

Hex Dump(D)… Displays the contents of the PROM in a Hex Dump format.

Up Load(L) Transfers the data in the active window to the buffer RAM of the PROM programmer.

Down Load(P)… Transfers the data in the buffer RAM of the PROM programmer to the active window.

Copy(R) Transfers the data in the PROM to the buffer RAM of the PROM programmer.

Write(W) Transfers the data in the buffer RAM of the PROM programmer to the PROM.

Verify(V) Compares and checks the data in the PROM and buffer RAM of the PROM programmer.

•••• Window menu

Menu Item Outline

New(N) Opens another window that has identical contents to the active window.

Cascade(C) Displays windows in an overlapping pattern.

Tile(T) Displays windows in a row.

Arrange Icon(A) Arranges icons in a specific order in the window.

All Close(L) Closes all the windows.

(Window list) Chooses the window to be active from a list of open windows.
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•••• ? (Help) menu

Menu Item Outline

Contents(C) Displays the contents of online help.

Search Keyword(S)… Uses keywords to search for topics in online help.

How to Help(H) Displays how to use Windows help.

Version(A)… Displays version information and copyright details.

(2) Toolbar

Frequently used functions can be executed with just one button using the toolbar.

Display of the toolbar can be switched on and off as necessary.

Figure 2-7.  Toolbar

Definitions (from the left): • New

• Open

• Save

• Save As

• Print

• Preview

• Cut

• Copy

• Paste

• Delete

• Undo

• Version

(3) MDI (Multiple-Document Interface) window

Multiple files can be opened on the same screen.

It is possible to move pattern data between windows (files).

The window is divided into 4 functions (split window): the pattern edit function, image view function, hex dump

function, and option data edit function, which allows the user to reference and edit a large volume of data.

By dragging the boundary of each split window, the size of the divided windows can be adjusted, and when

necessary, the user can choose not to display a certain split window.
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(4) Pattern Edit window (split window)

The character pattern is edited.

Turn ON (black) by left-clicking the mouse button and OFF (white) by right-clicking the mouse button.

The editing palette makes it easy to draw straight lines, make rectangles, and color areas.

Figure 2-8.  Pattern Edit Window (Split Window)

Editing palette

(5) Image View window (split window)

A compilation of character pattern images is displayed.

The scale of the displayed images can be changed (using the zoom function).

A number of character images can be selected by dragging, and by cut, copy and pasting, multiple character

images can be inserted and saved anywhere.  Editing cannot, however, be performed using the Pack format.

Figure 2-9.  Image View Window (Split Window)

(6) Hex Dump window (split window)

The character pattern hex dump is displayed.

By double-clicking the desired one byte, data can be directly rewritten.

Figure 2-10.  Hex Dump Window (Split Window)
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(7) Option Data Edit window (split window)

The option data is displayed.

Data can be edited by clicking the radio button of the desired item.

Figure 2-11.  Option Data Edit Window (Split Window)

(8) Status bar

The status of the active window, or an explanation of the operation is displayed.

The status bar can be switched on and off as necessary.

Figure 2-12.  Status Bar
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2.4.2 Comparison of DOS and Windows

The correspondence between the DOS Character Pattern Editor commands and the Windows menu is shown in

Table 2-1.

Table 2-1.  Comparison of DOS and Windows

Classification DOS Commands Windows Operations

*C-n (Change Hex command) Displayed in the Image View window

Edited using the [Edit(E)] menu

*D-n,m (Dump Hex commands) Displayed in the Hex Dump window

*K-n,m (Delete commands) [Edit(E)] → [Delete(D)] in the Image View window

*M-n,m,l (Move commands) [Edit(E)] → [Cut(T)] → [Paste(P)] in the Image View window

*l-n,m,l (Insert commands) [Edit(E)] → [Copy(C)] → [Paste(P)] in the Image View window

*GR-n (Graphic Editor command) Corresponds to the Pattern Edit window

*P-n,m (Print out character hexadecimal

data)

[File(F)] → [Print(P)]

*GP-n,m<,f> (Print out character pattern) [File(F)] → [Print(P)]

Write to/read a file [File(F)] → [Save(S)]

[File(F)] → [Save As(A)]

[File(F)] → [Open(O)]

*LOAD (Data Load command) [File(F)] → [Open(O)]

*SAVE-n,m (Character Data Save

commands)

[File(F)] → [Save(S)]

[File(F)] → [Save As(A)]

*OUT (Data Save command for ROM

Output)

[File(F)] → [Save(S)]

[File(F)] → [Save As(A)]

*OC (Option Setting command) Corresponds to the Option Data Edit window

*OD (Option Display command) Corresponds to the Option Data Edit window

Editor

*OP (Option Print command) [File(F)] → [Print(P)]

*RS (Select command) [Rom(R)] → [Setup(S)]

*RZ (Blank Check command) [Rom(R)] → [Blank Check(Z)]

*RD-x,y (Dump command) [Rom(R)] → [Hex Dump(D)]

*RL (Upload command) [File(F)] → [Open(O)]

*RP-p,q (Download command) [Rom(R)] → [Down Load(P)]

*RR-p,q (Copy command) [Rom(R)] → [Copy(R)]

*RW-x,y,p (Write command) [Rom(R)] → [Write(W)]

PROM

programmer

*RV-x,y,p (Verify command) [Rom(R)] → [Verify(V)]

*WHAT (Device Information Display

command)

Corresponds to the [Help] menu

*? (Help command) A command is not used

Others

*EXIT (Exit command) [File(F)] → [Exit(X)]
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2.5 Editor Functions

The Character Pattern Editor can be used to select the window that is best suited to the editing purposes of the

user.

(1) To create a new character pattern

Use the Pattern Edit window.  The editing palette in the Pattern Edit window makes it possible to create

patterns easily.

Because this window is interlocked with the Image View window, the character image of the edited character

can be checked at the same time as the character pattern is being created.

(2) To edit character hexadecimal data

Use the Hex Dump window.  Selected data can be cut, copied and pasted in 1-byte units.  By combining a

number of operations, hexadecimal data anywhere can be inserted, moved, or substituted.  Direct rewriting of

hexadecimal data is also possible.

(3) To edit option data

Use the Option Data Edit window.  Although option data differs between devices, the Option Data Edit window

will display the data that corresponds to the selected device.  Option data can be set simply by clicking one of

the radio buttons displayed in the Option Data Edit window.
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2.6 PROM Programmer Control Functions

The PROM programmer can be controlled using the Character Pattern Editor.  The functions that can be

controlled are as follows.

(1) Setting type of PROM programmer and type of PROM

Always set the above when the PROM programmer is used.

(2) PROM blank check

Checks whether PROM has been written to or not.

(3) Dump display of PROM contents

Displays the PROM contents (hexadecimal data) of a specified area.   When this command is executed, the

contents of PROM are first transferred to the buffer RAM of the PROM programmer.

(4) Data upload to PROM programmer

The character pattern data and option data in the active window are transferred from the PC to the buffer

RAM of the PROM programmer.

(5) Data download from PROM programmer

The data in the buffer RAM of the PROM programmer (character pattern data and option data) is transferred

to the active window and displayed.

(6) Copying PROM contents to PROM programmer buffer

The data in the PROM is transferred to the buffer RAM of the PROM programmer.

(7) Writing data to PROM

The data in the buffer RAM of the PROM programmer is written to the PROM.

(8) Verifying PROM data and PROM programmer

The contents of the PROM and the contents of the PROM programmer buffer RAM are compared (verified).
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2.7 Character Pattern Creation and Process up to Writing to PROM

Program activation

↓ Click the Character Pattern Editor icon

Device selection

↓ Select the device from the dialog box

Character pattern creation

↓ Create the character in the Pattern Edit window

Saving character pattern data

↓ [File] → [Save As] [*.SAV]

Option data setting

↓ Set in the Option Data Edit window

Saving character after conversion to ROM data

↓ [File] → [Save As] [*.OUT]

PROM selection

↓ [Rom] → [Setup]

PROM blank check

↓ [Rom] → [Blank Check]

Transfer of data to PROM programmer

↓ [Rom] → [Up Load]

Transfer of data from PROM programmer to PROM

↓ [Rom] → [Write]

PROM verification

[Rom] → [Verify]
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[MEMO]
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CHAPTER  3   FUNCTION  DETAILS

3.1 Device Selection

In order to edit the character pattern so that it corresponds to a specific device, the device to be used must be

selected.

Devices are selected using a device selection dialog box (Select Dialog).  When either [File(F)] → [New(N)], or

[File(F)] → [Open(O)] are chosen, the device selection dialog box is automatically displayed.  Select a device from

the list box.

Figure 3-1.  Device Selection Dialog Box

When the device has been selected, a dialog box allowing the user to select either a new MDI window or a file to

be opened is displayed.

Caution Unless a device is selected, the process cannot continue.  Note also that when the selected

device does not match the file that was read, it will not be displayed correctly on the screen.

Remark When creating a character pattern for the µPD6464A, select the µPD6464.
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3.2 Editor Functions

The editor functions are broadly divided into three classifications:

(1) Hexadecimal data editing

(2) Character pattern editing

(3) Option data editing

3.2.1 Editing using Hex Dump window

In the Hex Dump window, hexadecimal data can be modified, initialized, copied, or moved.

Figure 3-2.  Hex Dump Window

(1) Modifying hexadecimal data

Function Operation

Hexadecimal data selection Move the mouse pointer to the hexadecimal data to be modified and

double-click (this becomes a text box format).  Move to the next byte by

pressing the       key.

Hexadecimal data input Input 12 bits of hexadecimal numbers (00H to 3FH).  If other values are

input, the operation becomes [NG].

(2) Initializing hexadecimal data

Function Operation

Initialization of multiple data

(blank (3FH) setting)

<1>  Drag the section to be initialized and display it in reverse video.

<2>  Choose [Delete(D) DEL] from the [Edit(E)] menu.

Undo Choose [Undo(U) Ctrl+X] from the [Edit(E)] menu.

Example The selected section is initialized in the following way.
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(3) Copying hexadecimal data

Function Operation

Copy <1> Drag the section to be copied and display it in reverse video.

<2> Choose [Copy(C) Ctrl+C] from the [Edit(E)] menu.

(The copied data is held on the clipboard)

Paste <1> Move the cursor to the place where the data is to be inserted.

<2> Choose [Paste(P) Ctrl+V] from the [Edit(E)] menu.

Undo Choose [Undo(U) Ctrl+X] from the [Edit(E)] menu.

Example 31, 32, and 33 are inserted between 3A and 3B.

The data behind the insertion is shifted back.

(4) Moving hexadecimal data

Function Operation

Move <1>  Drag the section to be moved and display it in reverse video.

<2>  Choose [Cut(T) Ctrl+X] from the [Edit(E)] menu.

Paste <1>  Move the cursor to the place where the data is to be inserted.

<2>  Choose [Paste(P) Ctrl+V] from the [Edit(E)] menu.

Undo Choose [Undo(U) Ctrl+X] from the [Edit(E)] menu.

Example 31, 32, and 33 are moved to between 3A and 3B.
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3.2.2 Editing using Pattern Edit window

Character patterns can be created in the Pattern Edit window.  It is also possible to use the Image View window to

check the image of the character pattern being created in the Pattern Edit window.

Figure 3-3.  Image View Window

Editing palette

Character patterns are created in the Pattern Edit window using the tools on the editing palette.  [Cut(T)],

[Copy(C)], and [Paste(P)] on the [Edit(E)] menu can also be used.

(1) Pencil tool  

The pencil tool is used to draw freehand lines.  Lines of 1-dot width can be drawn.

To draw freehand lines:

<1> Choose the pencil tool from the editing palette.

<2> Drag the mouse pointer in the Image View window.

<3> Dot units can be erased with a right-click.

(2) Line tool  

The line tool is used to draw straight lines.  Lines of 1-dot width can be drawn.

To draw straight lines:

<1> Choose the line tool from the editing palette.

<2> Choose where to start the line and drag the mouse pointer.

<3> Choose where to end the line and release the mouse button.
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(3) Rectangle tool  

The rectangle tool can be used to draw black or white rectangles and squares.

To draw rectangles and squares:

<1> Choose the rectangle tool from the toolbox.

<2> Drag the mouse pointer as if drawing a diagonal line.

<3> A white rectangle can be drawn by dragging the mouse while holding down the right button.

Squares can be drawn by dragging the mouse pointer at a 45° angle.

Other kinds of rectangles can be drawn by dragging the mouse pointer in other directions.

(4) Rectangle selection tool  

The rectangle selection tool can be used to move any section.   A section that is the target of editing can be

encased in a rectangle and moved.

To select and move the area:

<1> Choose the rectangle selection tool from the editing palette.

<2> By dragging the mouse pointer diagonally, encase the section to be moved in a rectangle.

<3> Place the mouse pointer in the selected area, drag to the desired destination, and release the mouse

button.

Remark  It is impossible to undo this operation.

(5) Paint bucket tool  

The paint bucket tool can be used to color characters either black or white.

To color a character black or white:

<1> Choose the paint bucket tool from the editing palette.

<2> Place the mouse pointer on the character to be colored black (in the Pattern Edit window) and left-click.

<3> Place the mouse pointer on the character to be colored white (in the Pattern Edit window) and right-click.

(6) Eraser tool  

The eraser tool can be used to change dots in a black area to white.

<1> Choose the eraser tool from the editing palette.

<2> Place the mouse pointer on the dot to be changed to white and left-click.
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(7) Vertical flip tool  

This tool can be used to flip a character upside down.

Only an active character in the Pattern Edit window can be flipped.  Areas that have been specified by the

“rectangle selection tool” cannot be altered.

Figure 3-4.  Vertical Flip Tool

(8) Horizontal flip (mirror) tool  

This tool can be used to flip a character back to front.

Only an active character in the Pattern Edit window can be flipped.  Areas that have been specified by the

“rectangle selection tool” cannot be altered.

Figure 3-5.  Horizontal Flip Tool
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3.2.3 Editing using Pack format

A format in which a number of characters are linked together can be used in character pattern editing.

For this format, choose Pack from the View menu.  The desired Pack format can be selected by clicking a radio

button in the Pack format selection dialog box (Pack) that will be displayed.

Figure 3-6.  Pack Format Selection Dialog Box

Table 3-1.  Pack Format

Pack Format Form of Character Link

unPack Cancels the link.

Pack1 Links together 4 characters in both the upper and lower echelons.

Pack2 Links together 4 characters on both the left and right sides.

Pack3 Links together 8 characters.
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Examples of editing using the Pack format are shown below.

Figure 3-7.  Example of Editing Using unPack Format

Figure 3-8.  Example of Editing Using Pack1 Format
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Figure 3-9.  Example of Editing Using Pack2 Format

Figure 3-10.  Example of Editing Using Pack3 Format
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3.3 Image View Functions

Character patterns can be checked by using a character pattern view display.

(1) Zoom-up display

The character pattern display scale can be modified to enlarge and check the character pattern.

To modify the display scale, choose Zoom from the View menu.  The proportion of zoom required can be

selected by clicking the desired radio button in the zoom selection dialog box (ZOOM) that will be displayed.

Figure 3-11.  Zoom Selection Dialog Box
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(2) Copy, cut, paste, and delete

Multiple characters can be selected by dragging the section displaying the image.  By using the Edit menu or

buttons on the toolbar, the selected multiple characters can be copied, cut, pasted, or deleted.  Although

characters are shifted when cut or pasted, they will be shifted to either side of an input-prohibited area.

Characters selected from an input-prohibited area (Display Off data, 2-byte continuous command exit code)

cannot be cut or pasted.  Editing in the Image View window while characters are displayed in the Pack format

is also impossible.

<1> Example of a cut operation

008H: Display Off data

00BH: 2-byte continuous command exit code

Cut

Cut

Cut
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<2> Example of a paste operation

008H: Display Off data

00BH: 2-byte continuous command exit code

Contents of the clipboard:

Paste

Paste

Paste
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3.4 Option Data Function

This function sets the option data of the selected device.  Refer to 4.4 Device Information  for details of option

data.

Option data can be set by clicking the desired radio button in the Option Data Edit window with a mouse.

Figure 3-12.  Option Data Edit Window

• When devices that have options have been selected, be sure to save the set option data in a file in the *.OUT

format.  This data will not be saved if the *.SAV format is used.

• When devices without options are selected, nothing is displayed in the Option Data Edit window.
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3.5 File Save/Open

(1) To update and save a file:

Either click  on the toolbar, or choose [File(F)] → [Save(S)].

(2) To save in a separate file:

Either click  on the toolbar, or choose [File(F)] → [Save As(A)].  By doing either of the above, the dialog

box in Figure 3-13 will be displayed.  Select the type of file and save.  When files are saved in the *.SAV

format, a dialog box (Save width Set) that sets the character code to be saved will be displayed.  In normal

operations, save the file in the default format (which is set according to the selected device).

Figure 3-13.  Save in Separate File Screen

(3) To open a file:

Either click  on the toolbar, or choose [File(F)] → [Open(O)].  By doing either of the above, the dialog

box in Figure 3-14 will be displayed.  Select the file to be opened and click OK.

The file to be opened can either be a “*.SAV” or “*.OUT” extension file.

Attempting to open any other extension file will result in an error message.

Figure 3-14.  Open File Screen
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3.6 Device Information Reference

This displays information related to the selected device.

Choose [View(V)] → [Propaty(P)].

Figure 3-15.  Selected Device-Related Information Screen
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3.7 Print Function

To print the data that was created, either click  on the toolbar, or choose [File(F)] → [Print(P)].  By doing

either of the above, the Print dialog box (Print) will be displayed.

Select the print range by clicking the radio button of the data to be printed.  The selected data will be printed by

clicking the OK button.

To check the print image, choose [Preview(W)] in the Print dialog box.

To set the printer, choose [Printer(R)…] in the Print dialog box.

(1) Printing image view and hex dump

(2) Printing option data

When option data has been selected as the printing target, the selections in the range area appear dimmed and

therefore cannot be selected.
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(3) Preview

By choosing [Preview(W)] in the Print dialog box, or [File(F)] → [Preview(V)], or by clicking  on the

toolbar, the full-page print image can be checked on the screen.

Example   A4 paper, portrait (vertical), scale: 100%

Example   A4 paper, landscape (horizontal), scale: 100%
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(4) Printer setting

By choosing either [Printer(R)] in the Print dialog box, or [File(F)] → [Printer Set(R)], the printer and type of

paper to be used can be selected.

Figure 3-16.  Printer Setting Screen
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3.7.1 Print format

(1) Detailed view (character pattern)

Example  A4 paper, portrait, scale: 100%

Example  A4 paper, portrait, scale: 80%
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(2) Image view (character pattern)

Example  A4 paper, portrait, scale: 100%

(3)ý Hex dump (character hexadecimal data)
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(4) Option data

-----#237,21#'$7$#'803#-----

'(9,&(#1$0(#=#X3'9783

$''5(66#=#5333+# #35+

-----#237,21#'$7$#'803#-----

'(9,&(#1$0(#=#X3'9784

$''5(66#=#5333+# #34+

-----#237,21#'$7$#'803#-----

'(9,&(#1$0(#=#X3'9786

$''5(66#=#6&33+# #84+

-----#237,21#'$7$#'803#-----

'(9,&(#1$0(#=#X3'9789

$''5(66#=#5333+# #36+

-----#237,21#'$7$#'803#-----

'(9,&(#1$0(#=#X3'9794

$''5(66#=#7333+# #6'+
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3.8 PROM Programmer Control Functions

The PROM programmer can be controlled using the Character Pattern Editor.

Choose the appropriate function from [Rom(R)] on the menu bar.

Figure 3-17.  ROM Menu

(1) Setting PROM and PROM programmer types

When [Rom(R)] → [Setup(S)] is chosen, the dialog box in Figure 3-18 will be displayed.  Set the PROM and

PROM programmer types.  Until this setting is made, all options except Setup on the ROM menu will appear

dimmed and therefore cannot be selected.

Figure 3-18.  Setting of PROM and PROM Programmer Types
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(2) Blank check

When [Rom(R)] → [Blank Check(Z)] is chosen, a blank check of the PROM will begin.

Figure 3-19.  Blank Check Execution Screen

<1> Blank check result

When the check is complete, the check result from the PROM programmer will be displayed inside the

dotted lines in the message box of Figure 3-20.

Figure 3-20.  Blank Check Result Screen
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(3) PROM dump display

When [Rom(R)] → [Hex Dump(D)] is chosen, the dialog box that specifies the PROM addresses will be

displayed (Figure 3-21).  After clicking OK, the contents of the PROM in the specified range are displayed in

hexadecimal form.

The PROM contents in the PROM dump display are transferred once to the buffer RAM of the PROM

programmer, thereby overwriting the buffer RAM contents.

Figure 3-21.  PROM Address Input Screen

Figure 3-22.  Dump Data Collecting in Progress

Figure 3-23.  Dump Data Display
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(4) Upload

When [Rom(R)] → [Up Load(L)] is chosen, the hexadecimal data in the active window is transferred to the

buffer RAM of the PROM programmer.

Figure 3-24.  Upload Execution Screen

(5) Download

When [Rom(R)] → [Down Load(P)] is chosen, the dialog box that specifies the PROM addresses will be

displayed (Figure 3-25).  After clicking OK, the contents of the buffer RAM of the PROM programmer in the

specified range are loaded into the active window.

Figure 3-25.  PROM Address Input Screen

Figure 3-26.  Downloading in Progress
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(6) Copy

When [Rom(R)] → [Copy(R)] is chosen, the dialog box that specifies the PROM programmer addresses will

be displayed (Figure 3-27).  After clicking OK, the PROM data from address 0 to the specified end address

will be copied to the buffer RAM of the PROM programmer in the specified range.

Figure 3-27.  PROM Programmer Address Input Screen

Figure 3-28.  Copying in Progress
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(7) Write

When [Rom(R)] → [Write(W)] is chosen, the dialog box that specifies the write addresses will be displayed.

Specify the address range of the PROM programmer, which is inputting the data to be written, and the write

start address of the PROM.  After clicking OK, the data in the buffer RAM of the PROM programmer will be

written to the PROM.

Figure 3-29.  Address Input Screen

Figure 3-30.  Writing in Progress
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(8) Verify

When [Rom(R)] → [Verify(V)] is chosen, the dialog box that specifies the addresses of the data to be

compared will be displayed.  Specify the PROM address range and the PROM programmer start address that

will correspond to this range.  After clicking OK, the PROM data and the data in the buffer RAM of the PROM

programmer will be compared.

Figure 3-31.  Address Input Screen

<1> Verify result

The verify result from the PROM programmer will be displayed inside the dotted lines in the message

box.

Figure 3-32.  Verify Result Screen
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CHAPTER  4   ERROR  MESSAGES  AND  DEVICE  INFORMATION

4.1 Error Messages

Error messages are displayed in a message box.

Figure 4-1.  Message Box for Error Messages

Table 4-1.  List of Errors Occurring in Execution

Message Meaning

Address range error • The data that was to be read from a file or the PROM programmer exceeded the address range

of the device currently specified.

Bad character! • An incorrect code was read when the hexadecimal record was read from the PROM

programmer.

Check sum error! • The check sum of the hexadecimal record was incorrect.

Device type incorrect • The character data that was to be read and the pattern matrix of the device currently specified

were different.

File open error • The specified file could not be opened.

File read error • An error was generated when the file was read.

File write error • The free disk space in the file being written to was insufficient to hold all the data.

• An error was generated when the file was written to.

Hex file read error • An error was generated when the hexadecimal record was read from a file.

Insufficient memory! • There was insufficient memory to execute the program.

Invalid command • The command was invalid for the selected device.

Operand error! • The address range was incorrect.

• An address that modifies Display Off data was specified.

• An address that modifies the input-prohibited area was specified.

Printer error! • The printer was not ready.

Record type error • The type of hexadecimal code was other than 00H or 01H.
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4.2 Correspondence between Character Patterns and Hexadecimal Data

Figure 4-2 shows how character patterns correspond to hexadecimal data.  The data displayed in the Hex Dump

window, of which Figure 4-3 is an example, is arranged in 36 bytes (18 columns × 2 bytes) by lining up the

hexadecimal data in Figure 4-2 in order from right to left, starting from the top.

Figure 4-2.  Character Pattern and Hexadecimal Data

 [000H]
1 1 1 1 1 1 1 1 1 1 1 1
1 1 1 1 1 1 1 1 1 1 1 1
1 1 1 1 1 1 0 0 1 1 1 1
1 1 1 1 1 1 0 0 1 1 1 1
1 1 1 1 0 0 0 0 1 1 1 1
1 1 1 1 0 0 0 0 1 1 1 1
1 1 1 1 1 1 0 0 1 1 1 1
1 1 1 1 1 1 0 0 1 1 1 1
1 1 1 1 1 1 0 0 1 1 1 1
1 1 1 1 1 1 0 0 1 1 1 1
1 1 1 1 1 1 0 0 1 1 1 1
1 1 1 1 1 1 0 0 1 1 1 1
1 1 1 1 1 1 0 0 1 1 1 1
1 1 1 1 1 1 0 0 1 1 1 1
1 1 1 1 0 0 0 0 0 0 1 1
1 1 1 1 0 0 0 0 0 0 1 1
1 1 1 1 1 1 1 1 1 1 1 1
1 1 1 1 1 1 1 1 1 1 1 1

0 1 2 3 4 5 0 1 2 3 4 5
LSBLSB

Right Left

… 3FH 3FH

Left Right

… 3FH 3FH
… 3FH 3CH
… 3FH 3CH
… 0FH 3CH
… 0FH 3CH
… 3FH 3CH
… 3FH 3CH
… 3FH 3CH
… 3FH 3CH
… 3FH 3CH
… 3FH 3CH
… 3FH 3CH
… 3FH 3CH
… 0FH 30H
… 0FH 30H
… 3FH 3FH
… 3FH 3FH

Figure 4-3.  Example of Hex Dump Window Display
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4.3 Data Format

The configuration of character pattern hexadecimal data is based on the data format below.  Hexadecimal data is

saved in the *.OUT file in accordance with this data format.  An example of the configuration of hexadecimal data is

shown in Figure 4-4.

Data format  [D1, D2, D3, D4]

[Data format definition] D1: the number of rows in one block (8 bytes are treated as one block)

D2: the total number of valid blocks

D3: the valid bit length in one byte

D4: the number of columns in one block

Example  The format of dot-type 12 × 18 data will be [2, 6, 6, 3].

Figure 4-4.  Example of Hexadecimal Data Configuration

Total number of valid blocks: 6

Data of one character in a file: 3F 3F 3F 3F 3C 3F 00 00 3C 3F 3C 0F 3C 0F 00 00

3C 3F 3C 3F 3C 3F 00 00 3C 3F 3C 3F 3C 3F 00 00

3C 3F 3C 3F 30 0F 00 00 30 0F 3F 3F 3F 3F 00 00

One block = 8 bytes

Number of rows in one block: 2

Valid data of one character: 3F  3F 1 1 1 1 1 1 1 1 1 1 1 1
3F  3F 1 1 1 1 1 1 1 1 1 1 1 1 Number of columns in one block: 3

3F  3C 1 1 1 1 1 1 1 1 1 1 0 0

Valid bit length in one byte: 6

3F  3C 1 1 1 1 1 1 1 1 1 1 0 0

0F  3C 0 0 1 1 1 1 1 1 1 1 0 0

0F  3C 0 0 1 1 1 1 1 1 1 1 0 0

3F  3C 1 1 1 1 1 1 1 1 1 1 0 0

3F  3C 1 1 1 1 1 1 1 1 1 1 0 0

3F  3C 1 1 1 1 1 1 1 1 1 1 0 0

3F  3C 1 1 1 1 1 1 1 1 1 1 0 0

3F  3C 1 1 1 1 1 1 1 1 1 1 0 0

3F  3C 1 1 1 1 1 1 1 1 1 1 0 0

3F  3C 1 1 1 1 1 1 1 1 1 1 0 0

3F  3C 1 1 1 1 1 1 1 1 1 1 0 0

0F  30 0 0 1 1 1 1 1 1 0 0 0 0

0F  30 0 0 1 1 1 1 1 1 0 0 0 0

3F  3F 1 1 1 1 1 1 1 1 1 1 1 1

3F  3F 1 1 1 1 1 1 1 1 1 1 1 1



CHAPTER 4  ERROR MESSAGES AND DEVICE INFORMATION

User’s Manual  S13317EJ1V1UM0062

4.4 Device Information

4.4.1ý Device information list

The device information for OSD-use LSI is shown in Table 4-2.

Table 4-2.  Device Information List

Dot Matrix Device Character ROM

Capacity

No. of Editable

Characters

Display Off data 2-Byte Continuous

Command Exit Code

µPD6450 128 (00H to 7FH) 128 7FH −

µPD6451A 128 (00H to 7FH) 128 7FH −

µPD6453 240 (00H to EFH) 240 EFH −

µPD6454 256 (00H to FFH) 256 FEH FFH

µPD6456 128 (00H to 7FH) 128 7FH −

µPD6458 128 (00H to 7FH) 128 7EH 7FH

µPD6461 256 (00H to FFH) 256 FEH FFH

µPD6462 128 (00H to 7FH) 128 7EH 7FH

µPD6464A 128 (00H to 7FH) 128 7EH 7FH

µPD6465 256 (00H to FFH) 256 FEH FFH

12 × 18

µPD6466 512 (00H to 1FFH) 512 FEH, 1FEH FFH, 1FFH

Character patterns cannot be inserted in Display Off data, a 2-byte continuous command exit code, or an input-

prohibited area.
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4.4.2 Option data

(1) Option data addresses

The option data addresses of devices are shown in Table 4-3.

Table 4-3.  Option Data Addresses

Device Address Area Option Data Address

µPD6450 0000H to 1FFFH 2000H

µPD6451A 0000H to 1FFFH 2000H

µPD6453 0000H to 3BFFH 3C00H

µPD6454 0000H to 3FFFH −

µPD6456 0000H to 1FFFH 2000H

µPD6458 0000H to 1FFFH −

µPD6461 0000H to 3FFFH 4000H

µPD6462 0000H to 1FFFH 2000H

µPD6464A 0000H to 1FFFH −

µPD6465 0000H to 3FFFH −

µPD6466 0000H to 7FFFH −

The PROM and PROM programmers supported by the Character Pattern Editor are shown in Table 4-4.

Table 4-4.  PROM and PROM Programmers

PROM PROM Programmer

µPD27C256D/ADNote 1 AF-9703Notes 1, 2

µPD27C512Note 1 AF-9704Note 2

µPD27C1001Note 1

Notes 1.  A maintenance or discontinued product.

2. A product of Ando Electric Co., Ltd.  For further details please contact Ando Electric Co., Ltd.

(Tokyo +81-3-3733-1151).

Cautions 1. When writing to the PROM programmer, be sure to transfer the “*.OUT” file that was

created by this editor in order from address 0000H.

2. Use a floppy disk to order mask ROM. Orders are not being received for UVEPROM.
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(2) Contents of option data

µ PD6450

Address (MSB) Data (LSB)

7 6 5 4 3 2 1 0

2000H 0 0 0 0 0 0 * *

Character Signal Output Selection

0 Mask pulse output absent

1 Mask pulse output present

Pin Output Selection

0 BUSY, Clock output

1 Character signal output

µ PD6451A

Address (MSB) Data (LSB)

7 6 5 4 3 2 1 0

2000H 0 0 0 0 0 0 * *

Character Signal Output Selection

0 Mask pulse output absent

1 Mask pulse output present

Pin SelectionNote

0 V BLK × 1

1 R BLK, G BLK, B BLK

Note  In the µPD6451ACX, there are no blanking output options that support RGB (R BLK, G BLK, B BLK).

Be sure to set the pin to V BLK × 1.

µ PD6453

Address (MSB) Data (LSB)

7 6 5 4 3 2 1 0

3C00H 0 0 0 0 0 0 0 *

Character Signal Output Selection

0 Mask pulse output absent

1 Mask pulse output present
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µ PD6456

Address (MSB) Data (LSB)

7 6 5 4 3 2 1 0

2000H 0 0 0 0 0 * * *

Output Option Selection

00 OUTPUTA

01 OUTPUTB

1x OUTPUTC

Display Start Position

0 Line 1/dot 4

1 Line 9/dot 12

Remark   x: undefined

µ PD6461, 6462

Address (MSB) Data (LSB)

7 6 5 4 3 2 1 0

4000H/2000H 0 * * * * * * *

Dot Clock Selection

00 Setting prohibited

01 EXT CLOCK (external clock input)

10 LC (LC oscillation)

11 Setting prohibited

Output Format Selection

00 OUTPUT 10/20 (option B)

01 Setting prohibited

10 OUTPUT 10/21 (option A)

11 OUTPUT 11/21 (option C)

Output Pin Selection

0 RGB + 3BLK

1 RGB + Vc1 + Vc2

Display Position Selection

0 Position at line 9

1 Position at line 3

Command Input Selection

0 LSB-first

1 MSB-first

Caution When RGB + 3BLK is specified as the output pin selection, be sure to select option A as the

output format selection.
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[MEMO]
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CHAPTER  5   ORDERING  MASK  ROM  FOR  OSD-USE  LSI

Order mask ROM for OSD-use LSI in line with the flow shown in Figure 5-1.  For further details concerning

ordering mask ROM code, refer to the information document ROM Code Ordering Method .

Figure 5-1.  Flow for Ordering Mask ROM for OSD-Use LSI  (Receiving Floppy Disk Orders Only)

6HOHFWýWKHýSURGXFWýWRýEHýXVHGï

&UHDWHýFKDUDFWHUVýZLWKýWKHý&KDUDFWHUý3DWWHUQý(GLWRU1RWH

õ)ORSS\ýGLVNýRUGHUVýIRUý:LQGRZVýêïìîäèýVXSSRUWHGôï

1(&ýUHFHLYHVýWKHýIORSS\ýGLVNñýDQGýFUHDWHVýDQGýUHWXUQV
DýGLVNýIRUýFRQILUPLQJýWKHýGDWDï

(YDOXDWHýWKHýFKDUDFWHUýFUHDWHGýZLWKýWKH

&KDUDFWHUý520ý&KHFNý%RDUG1RWHýRQýWKHýVFUHHQï

6DYHýWKHýILQDOL]HGýFKDUDFWHUýGDWDýõóï287ýILOHôýRQýD

IORSS\ýGLVNýDQGýVXEPLWýLWýWRý1(&ï

&KHFNýWKDWýWKHýFRQWHQWVýRIýWKHýGDWDð

FRQILUPDWLRQýGLVNýPDWFKýWKHýILQDOL]HG

FKDUDFWHUýGDWDï

2UGHUýPDVNý520ï

Note  This board can be rented.  Contact an NEC distributor, or an NEC sales representative for details.

Use a floppy disk to order mask ROM code.  Be sure also to use the *.OUT file as the data save file.  The physical

format of the floppy disks used when ordering mask ROM code from NEC is as shown in Table 5-1 (September 1997

or later).
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Table 5-1.  Floppy Disk Format for Ordering Mask ROM Code

(a)  Floppy disk to be used

Size No. of Memory

Sides

No. of Tracks No. of Sectors Physical Record

Length

Memory Capacity

3.5 inches Double sided 77 tracks per side 8 sectors per

track

1024 bytes per

sector

1261568 bytes

(b)  Floppy disk format

OS Floppy Disk Format

MS-DOS Select a capacity of 1 MB as the floppy disk format (FORMAT d:/M)

PC DOS Select a capacity of 1.2 MB as the floppy disk format (FORMAT 12)Note

Windows 3.1 Select a capacity (C) of 1 MB as the floppy disk format (F)

Windows NTTM Select a capacity (C) of 1.25 MB as the floppy disk format (F)

Windows 95 Select a capacity (C) of 1.2 MB as the floppy disk format (F)

Note The floppy disk drive must support 1.2 MB.  Make sure to record $FDD12.SYS in CONFIG.SYS

beforehand.  Refer to the PC DOS manual for details.
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